
 
 

IMP VERSION 9 – RELEASE NOTES 
03 July 2017 

Version 9.0 of Imp, a fully automatic layout planning and imposition software, is now available for download. 

It is a major release packed with many features and multiple enhancements setting yet another benchmark 

when it comes to print layout planning and preparation. This document is a complete and detailed report of 

new features and enhancements in this version. 

Planning on Bigger Sheet Even If Die Cutting/Making Machine is Small 

In recent times, presses can print sheet sizes much bigger than the traditional 30in x 40in barrier. However, it 

is not often possible to upgrade all subsequent offline operations like die-cutting to such sizes. This problem 

is tackled by creating die-layouts which fit to the die-cutting machine; but the print layout is made bigger by 

stepping and repeating the die-layout. 

There is now a new option in Auto Settings dialog that will control if such layouts with sub-layouts should be 

considered or not. If this option is checked, Imp will automatically create layouts with step and repeat dies. 

This option is applicable even when planning with existing dies. 

 

Creating Sub-Layout Manually 

User can create a sub-layout by using the advanced menu 

option Create sub-layout as shown in the screen shot to 

the right. This brings up the usual Layout properties 

dialog but the controls to choose workstyle and the Order 

tab will be missing. 

Editing Sub-Layout 

Only the print-layout (parent layout) is shown in the plan tab. So, when you double click on a layout in the 

plan tab, the print layout will be opened for editing. The die-layout on the print-layout will simply be treated 

as a rectangular job that needs to be cut using a guillotine cutting machine. On the print-layout, you can select 

the sub-layout and move it, rotate it and do everything that you can do with a normal rectangular job on a 

layout. Crop marks will also be placed around the sub-layout. To edit the sub-layout, user must either double 

click on the sub-layout while editing the parent layout or select the sub layout and click on the edit pencil 

button in the toolbar. Doing that will open the sub-layout for editing in the same editor.  

Note: When you open a sub-layout for editing and then click on the Properties button, you will be editing the 

properties of the sub-layout.  



 
 

Sub-Layout Properties 

The properties dialog of a sub-layout is like the properties dialog of parent-layout. But the following fields 

will not be available for editing. 

- Workstyle combo 

- Order tab. 

- Control to enter the sheet count and wastage count will be disabled. Imp will always calculate these 

values automatically based on the jobs placed on the sub-layout. (This implies that splitting of same 

job across two layouts is not possible when sub-layouts are involved.) 

Automatic Placement of Registration Dots for Cutting Tables 

Registration Dots are dots placed on the layout for 

the digital cutting machine to automatically register 

the position and orientation of the sheet it is about to 

cut. The cutting machine will have cameras which will 

look for these dots placed on the layout. Such dot 

marks must be both printed and made part of the die 

that is exported from Imp. 

Changes to Auto Mark Settings 

Auto Mark Settings dialog now looks as shown in the 

snapshot. There is a new tab called Dynamic Marks. 

Marks which are positioned dynamically are placed in this tab. While Crop & Fold marks controls were simply 

moved from another tab to this new tab, the controls for Registration dots are new. 

Dot Mark 

Dot marks are implemented internally 

using ellipse marks. So, when the 

marks are finally added on the layout 

by Imp automatically, they will appear 

as Ellipse marks.  So, some of the 

mark properties entered in the dialog 

box to the left map directly to the 

properties of Ellipse Mark. However, 

couple of inputs are special to dot marks. 

Space around: This is the amount of empty space that must be available around the dot. This is like the silent 

zone entered for bar codes. These empty zones are required so that the scanning machine (or camera) can 

recognize the dot. 

Requird nos: This input defines the number of dots that the user wants to be placed on the layout. 



 
 

Automatic Placement of Dot Registration Mark 

A minimum of 3 dot marks are usually required for the cutting machine to automatically register the position 

and orientation of the sheet placed on its table. Imp tries to disperse the dots on the layout trying to keep 

them as far as possible from each other. This is how Imp’s placement logic works. 

- Identify empty places on the layout where dot marks can be placed. 

- Empty places which can accommodate the dot as well as provide for empty Space around. 

- The software chooses placement points such that the dispersion of points is maximum. 

Marks for Operations Other than Printing 

Every operation has its own demands on marks. When a printing operation is present, color bars, registration 

marks and other marks become necessary. When a digital cutting process is present, some special dots are 

required to be placed on the layout. Now marks template can be selected not just against presses but also 

against die-cutting machines, die-making setups & digital cutting machines. In the case of digital cutting 

machine, user can also select the size of the dot marks that must be placed against each digital cutting 

machine. This will allow the 

software to handle the 

situation where two different 

digital cutting machines and 

have different dot size 

requirement. 

When a layout has a press, 

die-making setup and then a 

die-cutting machine, it is 

possible that 3 marks 

template are applied to this 

layout (if the user selected a marks template for each of the machines.) 

Marks Margin for Die-Cutting, Die-Making & Digital Cutting Machines 

A side effect of this is that even die-making setups, die-cutting machines and digital cutting machines can 

define marks margin in the configuration window. Imp planning engine will do all the required combinations 

and intersections to ensure that the margin requirements for all operations are respected. 

Please note that the gripper margin for sub-layout is derived from the die-cutting machine and not from press. 

Improved Pure Nesting Algorithm 

Enhancements have been made to the pure nesting algorithm. These enhancements will have the following 

effects 

- Jobs will not scatter to the corners of the sheet. Jobs will remain compacted to one side of the layout 

- Speed of computation 



 
 

Support for Flexo Presses 

There is a new category for Flexo presses in configuration window. The following 

specialities of Flexo press have been taken care of by this new development. 

• Plate size is not fixed. It varies based on the size of the layout 

• Cost of the plate is calculated in terms of cost per unit area. 

• Certain Flexo presses are intermittent which allow any cut-off value where are some are not and have 

a fixed number of allowed web cut-off values. 

Possible to Create Layouts without Selecting a Press 

There is a change in the user interface of the Edit Layout Properties dialog and Auto Settings dialog. In both 

these dialogs, it was previously mandatory to select a press. This is now optional. 

- If a press is not selected in Auto Settings dialog, jobs that require printing will not be planned. Only 

those jobs that do not have inks or coatings to be applied on both front and back will be planned. 

- Even if a press(es) is selected at the planning stage, layouts created for jobs that do not require 

printing will be planned successfully and will not have a press assigned to it. 

Jobs are Not Planned if Required Machines are Not Selected 

Until now, it was OK if a die-cutting machine was not selected even if jobs had non-rectangular geometry. 

Imp was creating layouts without a die-cutting machine for such jobs in such situations. It is no longer the 

case in version 9. Only those jobs for which all required agents are selected will be planned successfully. 

- Non-rectangular jobs will not be planned if a die-making or a die-cutting machine is not selected. 

However, if a digital cutting machine is selected, planning will go through. 

- Rectangular jobs will not be planned if a guillotine cutting machine or a digital cutting machine is 

not selected. 

- Jobs with inks will not be planned if a press is not selected. 

The goal is that user must simply be able to select all agents for all process and Imp automatically figures 

out the required combination to process the given job in the cheapest way. 

There are multiple places inside Imp where a warning is raised if a required machine is not selected 

- On pressing OK button in Edit Layout Properties dialog, if a required machine is not selected. 

- As a tooltip on top of the layout view in the Plan tab. It is the same place where collision or grain 

mismatch warnings are shown. 

- In the PDF/JDF export dialog as an imposition warning. This imposition warning is also taken up in 

ImpFlow when an imposition warning valve is used in the flow. 

There is now a more explicit indication of warning for layouts with a warning symbol drawn at the right top 

of the layout view in the Plan tab as shown in the snapshot to the right. User can hover the mouse on this 

warning symbol to get a quick tooltip about what is wrong. 



 
 

Allowing Overruns 

It is now possible to define, in percentages basis, the extent of overruns allowed on a job. When calculating 

the Profitability Index, Imp will take the allowed excess copies into account. This option usually comes in 

handy when a single job is split into multiple batch orders and excess in one batch can be compensated 

against a subsequent batch. 

 

- PPXML format has been extended to support this new property on component. 

Disallow Ganging on Certain Jobs 

There is a new option in the Printing tab of both bound & unbound components which allows the user to 

disallow ganging of that component. If this option is checked, this component (or its signatures) will not be 

ganged with other components while auto planning. 

- PPXML has been extended to support this new property on components. 

- Set Component Properties action in ImpFlow now supports setting this property. 

- PDF, DXF or CF2 name parsing can also parse this property. 

Enhancements to Planning with LYT 

• Along with an LYT file(s), CF2 files can also be selected when planning based on existing dies. 

• There is a new variant of Plan with LYT/CF2 files which allows Imp to consider creating new 

dies/layout if needed. Plan only with LYT/CF2 Files option will only create layouts which are based 

on a LYT or CF2 file whereas Plan along with LYT/CF2 Files option will calculate new layouts along 

with layouts which are based on selected LYT or CF2 files. 

  

• Push & Pop planning now supports planning based on a layout template, LYT or  CF2 files. 

• Layouts created based on a LYT or CF2 file will have a small caption at the bottom to indicate the 

source file based on which the layout was created. 

 



 
 

• Die-making cost for layouts which are based on a LYT or CF2 file will be zero. 

• The reference to LYT/CF2 file will be dropped the moment the layout is unlocked (presumably for 

doing some changes to the layout.) 

Note: There are some differences in working with LYT files and CF2 files. 

- LYT files carry marks information too. So, marks will be placed as in the LYT file and not based on the 

marks settings chosen in Tool → Marks settings. CF2 files do not carry any marks so marks will be 

applied based on Auto Mark Settings 

- LYT files carry sheet size information and the offset of the jobs on that sheet. So, if the same sheet 

size is suggested, Imp will automatically offset jobs based on the offset in LYT file. CF2 files do not 

contain sheet size information. 

Automatic Inference of Inks & Coatings of Layout 

Inks & Coatings to be applied on each side of a layout are now automatically inferred based on the jobs placed 

on that layout. The controls to select inks & coatings of a layout will be found missing in Edit Layout/New 

Layout dialog. This simplifies the workflow for manually creating layouts. 

Automatic Setting of Sheet Cut-size by Removing White Area 

It is common to remove excess white area on the edges of the sheet (by trimming) before printing. It is 

typically done to reduce area of the sheet in post press processes like lamination, varnish etc. Hence two new 

features have been introduced to make it easy for users to set this pre-trimming of sheet for removal of excess 

margins on the original sheet. 

• Auto Plan Settings dialog has a new option as shown below. Checking this option will ensure that 

pre-trimming will be automatically set on layout computed by Imp. 

 
• A button in the Layout Editor, as shown below, gives the user quick access to set the sheet trim. 

 

Notes: Earlier option of doing the same from Edit Layout Properties dialog is still available. 

Changes to Make Ready Time & Wastage Calculation for Work & Turn/Tumble 

In previous versions, Imp always worked with the assumption that there is no significant make ready time or 

wastage while printing the back of a layout with Work & Turn/Tumble workstyle. This is probably not true. In 

this version, make ready time and wastage for back of a layout for such workstyle is defined as a percentage 

(reduction) of the same for front of the layout. 



 
 

 

A 100% indicates that there is no additional make ready time or wastage when processing back of the 

layout/sheet. 0% will indicate that make ready time or wastage for printing the back is same as front. 

Action to Automatically Import Material CSV in ImpFlow 

There is a new action in ImpFlow called Import material CSV under the Other section. As the name states, 

this action simply updates the material configuration through a CSV file. Whenever a CSV file is dropped in 

the watch folder of the flow, this action will kick in and import the material CSV. Note that there cannot be 

any subsequent action following this action. Typical use case would be as follows: 

Create a new flow and have "Import material CSV" as the only action in that flow. Place this flow as the first 

flow in the list of flows in ImpFlow which implies that this flow is of highest priority. Third party MIS or a 

material inventory software will periodically (or whenever there is a change in the material configuration) 

create a CSV file in the folder watched by this flow. 

Enhancements to User Interface 

• Button to add a new plan to the product is available in the vertical product toolbar. 

• The layout(s) (and the plan it belongs to) on which a job is placed is indicated in the menu that shows 

up when clicked on * in Product Sheet. 

 
• Double click on the content column to open file explorer with the folder containing PDF file selected. 

• It is now easy to distinguish between planned and unplanned components at the time of adding 

components to a plan. 



 
 

 
• A vertical scroll bar is provided when number of properties selected to be displayed in the Computing 

Layouts window is huge. 

• Explicit way to add components from DXF or PDF to an open product. Previously, this was possible 

only by drag & drop of files. 

 

Changes to Preferences 

Some changes have been done to the 

Preferences dialog accessed from 

Tool → Preferences menu. 

Extended Properties Moved Out 

Tabs in the Preferences dialog which 

were used to set default extended 

properties on Product, component & 

layout have now been moved out to a 

separate dialog called Extended 

Properties accessible from Tools → 

Extended Properties menu. 

Some ini Options Moved to Preferences 

The following two options which were previously controlled through impui.ini file are now controlled through 

the General tab in Preferences dialog. 



 
 

 

Renaming of Units & Other tab 

The units & others tab in Preferences tab has been renamed as User Interface. Options in this tab which were 

not related to user interface have been moved into the General tab. 

Changes to Auto Plan Settings 

• The grouping option to isolate jobs into groups on the same layout now works even for irregular 

nesting algorithm. Previously, it was applicable only to Rectangular nesting algorithm. 

 
• There is now a separate tab for grouping options in the Auto Plan Settings dialog. Previously these 

options were part of the Options tab. 

• Controls (checkboxes) in Options tab have been rearranged and grouped as those which add 

constraints and those do not. For example, the option [ ] Do not consider derived sheets is a constraint 

on the capability of the software and hence is added under the constraints section. 

• A new constraint option in Auto Plan Settings which limits the sheet count per layouts has been 

introduced. 

• A new constraint option in Auto Plan Settings which limits the number of jobs that can be placed on 

a layout has been introduced. 

 
• A new option in Auto Plan Settings to ignore no-print margin of presses while auto planning a bound 

component has been added. 

Other Notable Features 

• Push & Pop planning and all its new flavours are now available in ImpFlow. 

 
• In the Die Database Search dialog, user can select multiple dies. All the selected dies will be 

considered at the time of auto planning. 



 
 

• PDF marks can now be arranged in sub-folders inside the Marks folder of Imp. This will help in 

grouping and managing PDF mark files. 

• Importing of CSV Format 1 is now supported in ImpFlow. 

• An Issue with dragging and dropping of Line Mark has been fixed. 

• Imp now indicates the selected die-cutting, die-making, digital cutting or guillotine cutting, 

whichever is relevant, in layout reports when [ ] Cutting details is selected in Layout Report Settings. 

• Digital sheet-fed presses now support two different speed parameters. One for simplex printing and 

one for duplex. 

• It is now possible to unlock a locked layout from the Layout tab as well. 

 
• It is now possible to parse job properties from a DXF or CF2 filename, just like it was possible with 

PDF filename. 

• Computation of number of guillotine cuts required for a layout is 

CPU intensive. Doing this calculation over multiple layout options 

calculated by Imp can have an impact on the speed of layout 

calculations. For this sake, an option to ignore guillotine cutting cost while planning has been 

introduced, thus removing the need for the software to compute guillotine cut count at the time of 

computation if this option is checked. 

• QR code marks can now be added much the same way as a Barcode mark or a Text mark. 

• User can now filter computed layouts to see only those layouts which are based on an existing die or 

layout template. 

• Make ready time for die-cutting machines can now be entered as a function of number of stations/ups 

on the die-layout. 

• Minimum and maximum allowed web cut-off values can now be entered for a reel sheeting machine. 

These cut-offs will be considered while auto planning to ensure layouts are created within this valid 

range. 

• Creep compensation related properties on bound component can now be set through the Set Bound 

Component properties action in ImpFlow. 

• It is not possible to control the jog position of individual rows in a signature template of multiple web. 

• When creating a product from CSV Format 2 file, if PDF file for a row is available, Imp will ignore the 

job size defined ahead in that row and use the PDF page trimbox to set the dimensions of the job if 

the following option in Preferences dialog is selected. 

 
For the Import CSV (Format 2) action in ImpFlow, there is a new option as follows. 

 



 
 

• There is now a separate checkbox in the PDF Export Settings dialog to generated imposed PDF with 

dimensions. 

  
• It is now possible to force Imp to load the latest CSV file with sheet sizes and other substrate 

information, just before auto planning. This option is controlled through an impui.ini flag 

AutoLoadBeforePlanning under the [MaterialImport] section. 

• There is a new option in Layout Report Setup which allows for printing layout diagram with or 

without dimensions. In previous version, dimensions were always printed. 

 
• It is now possible to generate layout diagram in reports along with the PDF content of jobs. PDF 

content can only be shown for unbound jobs and not for book signatures. 

 
• Bristol basis size is now supported (along with Bond, Book, Cover, Index & Tag). 


